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CHAPTER 1

Introduction
Flare's workspace is flexible, uses a modern Multiple Document Interface (MDI), and gives you several options to work the way that you want. This manual focuses on some of the more important
parts of the workspace. For more information about other areas of the interface, see the online
Help.
This chapter discusses the following:
Main Sections of the Interface
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Explorers and Window Panes

12

Editors

13

Tabs and Accordions

14

6

Main Sections of the Interface
The user interface consists of the following major sections:
n

Top—Ribbons or Tool Strip The top portion of the Flare interface displays either a ribbon view,
or a tool strip view, which are used to access features.
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n

Left—Explorers and Window Panes The left side of the Flare interface is the default location
for many different explorers and window panes (e.g., Content Explorer, Project Organizer),
which can be used to create, open, and view various elements in the project.
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n

Middle—Editors and Start Page The large middle section of the Flare interface is the default
location for the many editors in Flare (e.g., XML Editor, TOC Editor, Stylesheet Editor), which
are used to enter and design the vast majority of the content for your project. It also displays
some window panes (e.g., File List, Analysis Summary window) and the Start Page, which is
used for quickly performing high-level tasks and accessing information.
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n

Right—Window Panes The right side of the Flare interface (like the left side) is the default location for many different window panes (e.g., Dynamic Help, Styles window pane).
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n

Bottom—Window Panes The bottom area of the Flare interface is the default location for yet
more window panes (e.g., Builds window pane).

For the most part, the explorers and window panes on the edges of the interface are used to support the work that you do in the middle. You have the flexibility to close or move elements around as
you like, so it is not mandatory that every window pane remain permanently in its default location.
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Explorers and Window Panes
Flare has numerous window panes in the interface that are used for a variety of purposes. The three
panes that you are likely to use most are the Project Organizer, Content Explorer, and Builds window
pane. Some of these panes are located by default on the left side of the workspace, some on the
right side, some in the middle, and some at the bottom. Some elements are contained in window
panes as opposed to dialog windows because they contain features that you would want to have
easy access to as you work in an editor. If more than one window pane is open on either side, the
panes are organized in an accordion or tab structure. This means that they are stacked on top of
each other, with the active window pane displayed "in front" of the other panes. You can click any
accordion bar or tab to bring that particular window pane "in front" so that you can work in it.
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Editors
The large middle section of the workspace is typically used to display many different editors,
depending on the type of element you are working on. You can have many editors open at the same
time—even many different pages of the same editor. For example, you can have five different topics
open, each one displayed in a different instance of the XML Editor. Some of the most important and
commonly used editors are the XML Editor, Internal Text Editor, Stylesheet Editor, TOC Editor, Skin
Editor, and Page Layout Editor.
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Tabs and Accordions
Each open document in the workspace has a tab or accordion that lets you access it. The most
recently opened document is in front, while other open documents are behind it. You can bring a
document into view by clicking its tab.
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You can also work with these document tabs in the following ways.

Drag Tabs
You can click and drag tabs to the right or left to change their order.
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Tab Options
You can choose how to view window panes in the workspace.
n

Accordion tabs Stacks the document tabs below the window pane or editor.

n

Standard tabs on top Places the document tabs on the top of the window pane or editor.

n

Standard tabs on bottom Places the document tabs on the bottom of the window pane or
editor.
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To switch between tabs, right-click the title bar of the window pane or editor and select a view.
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Hidden Documents
You can open as many documents as you need in the interface. When you have opened more documents than can be shown, the hidden documents can be accessed by clicking a drop-down menu
on the right side of the workspace.
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CHAPTER 2

Start Page
The Start Page is a handy window pane that displays when you first launch Flare and remains open
unless you close it. You can use the Start Page to open and create projects, view the online Help,
and see news and updates. If you do not see it, select View > Start Page.
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CHAPTER 3

Content Explorer
The Content Explorer (along with the Project Organizer) is one of the most-used elements in the
Flare interface.
Just as it sounds, the Content Explorer is used to hold all of the content-related items in your project—both topics and non-topic files.
This chapter discusses the following:
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How to Open the Content Explorer
Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the View ribbon. In the Explorer section select Content Explorer.

n

Keyboard Shortcut Press CTRL+J on your keyboard.
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Where Each Type of File is Stored
You can store new files anywhere you like in the Content Explorer, either in the root Content folder
or in any subfolders under it. You may want to create and organize subfolders so that topics are
stored in certain folders and non-topic files (e.g., images, page layouts, snippets) are stored in different folders.
Traditionally, Flare has used a Resources folder and different subfolders within it to store non-topic
files. If you want to place non-topic files in a traditional default folder, you must first make sure that
folder exists in the Content Explorer. If it does not exist, you can easily add it.
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What You Can Do in the Content Explorer
Non-Topic File Type

Recommended Default Folder in Content Explorer

Image

Resources > Images

Master Page

Resources > MasterPages

Micro Content

Resources > MicroContent

Multimedia

Resources > Multimedia

Page Layout

Resources > PageLayouts

Snippet

Resources > Snippets

Stylesheet

Resources > Stylesheets

Table Stylesheet

Resources > TableStyles

Following are the primary tasks that you can perform in the Content Explorer:
n

3D Models (Insert) You can click on a U3D file in the Content Explorer and drag it to the XML
Editor. This inserts a 3D model into that file.

n

Audio (Insert) You can click on an audio file in the Content Explorer and drag it to the XML
Editor. This creates an audio object.

n

Cross-References (Insert) You can click on a topic file in the Content Explorer and drag it to
the XML Editor. This creates a cross-reference.

n

Folders (Add) When you create topics, they are added to the root folder in the Content
Explorer if you accept the default settings. As your list of topics grows, it may become somewhat difficult to find a specific topic when you want to work on it. In order to keep your topics
organized and easier to find, you can create subfolders in the Content Explorer and move topics into them.

n

Images (Insert) You can click on an image file in the Content Explorer and drag it to the XML
Editor. This inserts the image.

n

Images (Add/Open) You can open an image that you have added to your project. When you
open the image, it displays in the Image Viewer within Flare.
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n

Master Pages (Add/Open) A master page is an element that you can create in your project in
order to apply certain content to multiple topics. A master page is primarily used in online outputs, but it can be used in Word output as well. Depending on the output type, you might use a
master page in online output to apply features such as breadcrumbs, menus, toolbars, search
bars, mini-TOCs, or footer text to multiple topics, or even all topics in a target. For Word output, a master page allows you to determine page specifications (such as size or orientation)
and to apply certain content (such as header text or page numbers) to many topics in a
manual. For print-based outputs other than Word, page layouts are used instead of master
pages.

n

Micro Content (Add/Open) Micro content is what it sounds like—short, concise information
that stands alone and is easily consumable. In Flare, it begins with the creation of a collection
of brief phrases and corresponding responses, such as questions and answers. After generating HTML5 output, these phrase/response combinations can be used in different ways as
users interact with your output. Among other benefits, it can greatly improve the user experience when people search in your HTML5 output.

n

Movies (Insert) You can click on a movie file in the Content Explorer and drag it to the XML
Editor. This inserts the movie.

n

Page Layouts (Add/Open) A page layout is an element used for page specifications (e.g., size,
margins) and to apply certain content (e.g., headers, footers, page numbers) to many (or all)
topics in print-based output. It allows for easy configuration through the use of content
frames, bleeds, crop marks, registration marks, margins, padding, alignment features, and
more. Page layouts are similar to master pages, but are more flexible and easier to use. The
general rule of thumb is that page layouts are recommended for print-based output (when possible), and master pages continue to be the best method for automatically adding headers,
footers, and breadcrumbs in multiple topics for online output. Another difference between
page layouts and master pages is that page layouts can be used for any of the print-based outputs (Adobe PDF, Microsoft Word), whereas master pages can be used only for Microsoft
Word when creating print-based output.

n

Properties Dialog (Open) You can open the properties dialog for individual content items by
selecting them and clicking . From the Properties dialog you can perform a variety of tasks,
depending on the type of file you selected.

n

Snippets (Add/Open) A snippet is a file that is sort of like a miniature topic. You can insert and
format text, tables, images, and whatever else can be included in a normal topic. A snippet
can be inserted into one or more topics throughout your project, thus allowing you to reuse
content that is maintained in one place. You can even insert them into other snippets, cre-
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ating nested snippets. We’re not usually talking about single words or phrases; that’s what variables are for.
n

Snippets (Insert) You can click on a snippet file in the Content Explorer and drag it to the XML
Editor. This inserts the snippet.

n

Stylesheets (Add/Open) A stylesheet is a file with a .css extension (cascading stylesheet) that
holds style classes and their properties. You need to associate a stylesheet with a topic if you
want to use the style classes in that topic.

n

Table Stylesheets (Add/Open) This is a stylesheet that lets you create and use different styles
that pertain specifically to tables in your project.

n

Topics (Add/Open) A topic is a chunk of information about a particular subject. Topics are the
most important part of a project. Everything else is contained within topics (e.g., hyperlinks,
text, images) or points toward topics (e.g., table of contents, index, browse sequences). The
very reason end users open a Help system or refer to a manual is to find information, a little direction. They find that help within individual topics.
TIP: When adding a new file to the Content Explorer, the recommended method is to rightclick on the folder in the Content Explorer and use the New menu option. This is the most
efficient way to direct the new file to the folder where you want to store it. That's because
the Add File dialog opens when you add a new content file, and this method ensures that
the folder you want is already selected in that dialog.
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Navigation Buttons
Following are explanations of the navigation buttons in the Content Explorer:
Button/Section

Description
Lets you move the window pane from its docked position to another location in
the interface. Simply click on this area and drag the window pane to the new location.
Opens a drop-down menu with commands for moving and resizing the window
pane.
n

Close Closes the window pane.

n

Dock Attaches the window pane to the interface if it is floating.

n

Auto Hide "Pins" the window pane to the side of the interface so that you
have more room for your workspace. You can show the window pane by
hovering over the thin bar on the side of the interface. If you select this
option again, the window pane returns to its previous state (no longer
"pinned" to the side of the interface).

n

Float Detaches the window pane from the application so that it becomes
a free-floating element in the interface.

n

Standard Tabs (Top) Arranges window panes so that traditional tabs are
displayed at the top.

n

Standard Tabs (Bottom) Arranges window panes so that traditional tabs
are displayed at the bottom.

n

Accordion Tabs Arranges window panes so that they are stacked with
accordion tabs.

"Pins" the window pane to the side of the interface so that you have more room
for your workspace. You can show the window pane by hovering over the thin
bar on the side of the interface. If you select this option again, the window pane
returns to its previous state (no longer "pinned" to the side of the interface).
Closes the window pane.
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Buttons and Sections
Following are explanations of the different buttons and sections in the Content Explorer:

Button/Section

Description
Toggles between showing or hiding the subfolders in the Content
Explorer.
Splits the Content Explorer into two halves. The right half shows additional details for the files. You can use the down arrow to view the files
on the right in a list format or in a tile format.
Expands all of the folders so that you can see all of the files under each
one.
Collapses all of the folders so that you can no longer see all of the files
under each one.
Lets you show or hide the small squares next to each folder and file,
which are used to show colors representing condition tags that have
been applied.
Moves up one folder in the hierarchy. This button becomes enabled if
you use the Split View button
side of the split view.

and select a file or folder on the right

Refreshes the window pane so that the latest information is shown.
Opens the selected item.
Opens the Properties dialog for the selected item.
Creates a new custom folder, which you can use to organize your files.
Opens the Add File dialog, which lets you create a new topic or import
one from outside the project.
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Button/Section

Description
Lets you limit the files that are displayed by file format.
n

All Files Displays all files.

n

Topic Files Displays only the topic (HTM and HTML) files.

n

Master Page Files Displays only the master page (FLMSP) files.

n

Page Layout Files Displays only the page layout (FLPGL) files.

n

Snippet Files Displays only the snippet (FLSNP) files.

n

Micro Content Files Displays only the master page (FLMCO) files.

n

Stylesheet Files Displays only the stylesheet (CSS) files.

n

Image Files Displays only the image files.

n

Multimedia Files Displays only multimedia (audio, video, and 3D
model) files.

n

GIF Files Displays only GIF files.

n

JPEG Files Displays only JPG and JPEG files.

n

PNG Files Displays only PNG files.

n

Flash Movie Files Displays only SWF files.

Displays the color of condition tags that are associated with the file (if
any). Condition tags are used to determine specific content or files to
be included in some targets but not in others.
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Button/Section

Description
n

Git and Subversion This indicates that the file has been modified.
You can commit the file when you are ready. If your project is
bound to Subversion, you can commit the file when you are ready
(if you are the user who has modified it, or if you have stolen the
lock on the file from another user).

n

Perforce This indicates that the file has been checked out from
source control. You can submit the file when you are ready (if you
are the user who has checked it out).

n

TFS and VSS This indicates that the file has been checked out
from source control. You can check in the file when you are
ready (if you are the user who has checked it out).

You will see this icon for all source control providers.
This indicates that you have a file in your project but have not yet added
it to the integrated source control application. This might occur, for
example, if you create a new topic and do not add the file to source control during the topic creation process. To resolve this, simply right-click
on the file and select Source Control > Add.
You will see this icon for all source control providers.
This indicates that the file is added to source control but is not currently checked out, which means that it contains a "Read Only" designation in its properties. In order to edit the file, you must check it out
from source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server or Perforce.
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Button/Section

Description
This indicates that another user has locked the file. You will often see
this icon in conjunction with the icon, indicating that another user is
both using the file and has locked the file. You can make changes to
this file even if another user has locked it.
If your project is bound to Subversion and you need to commit the file in
while another user is working on it, you can steal their lock. To do this,
right-click on the file and select Source Control > Lock. In the Lock dialog, select Steal the lock, then click Lock.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
This indicates that you have locked the file. You will often see this icon
in conjunction with the icon, indicating that you have both locked and
modified the file. Other users can make changes to this file even if you
have locked it.
If your project is bound to Subversion, other users can steal your lock.
If you are using Team Foundation Server, you can lock a file when you
check it out.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, or Perforce, or Subversion.
n

Perforce and Subversion This indicates that the file is currently
being modified by another user. You will often see this icon in conjunction with the icon, indicating that another user is both
using the file and has locked the file.

n

TFS This indicates that the file is currently checked out to
another user. You can send a request to the user, asking that person to check in the file so that you can check it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
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Button/Section

Description
This indicates that the file is not current (i.e., the local copy of the file is
older than the source control copy). This might happen if another user
checks out the file, makes changes to it, and checks it back in to source
control. If this occurs, you can check the file out or get the latest version of the file from source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
This indicates that a file has been renamed, but not modified in any
other way. If you make any additional changes to the file, such as editing the text or adding a condition tag, the renamed icon is replaced
by a icon.
You will see this icon if your project is bound to Subversion.
This indicates that the file is deleted from source control, but you still
have a copy of the file on your local machine. If necessary, you can add
the file to source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server.
This indicates that the file is mapped to an external resource or
SharePoint file.

[Preview Bar]

This is the area at the bottom of the Content Explorer. When you click
on a folder or file, this bar shows its name, size, and last modified date.
When you click on an image file, a small copy of that image is shown, as
well as its resolution and dimensions.
If you have set the online or print DPI for an image using MadCap Capture, these values are also shown.
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TIP: If you have a content file open and want to quickly find where it is stored in the Content
Explorer, you can right-click in the file and select Locate in Explorer. You can also open the
Project ribbon and click Locate in Explorer. Flare opens the Content Explorer, expanding
folders to show where the file is located.

TIP: You can quickly insert a text hyperlink to a file (e.g., topic, image, snippet) in the Content Explorer. To do this, click and drag the destination file from the Content Explorer to the
location in the topic where you want to insert it. As you drag the file into the topic, a vertical
red bar acts as a guide to help you place the link in the topic. When you release the mouse
button, the Insert Hyperlink dialog opens. You can modify any fields in the dialog (if necessary) and click OK to insert the hyperlink.

NOTE: If you are working with HTML Help and import a RoboHelp project that has been
merged with other CHM files or includes shortcut controls, the linked files are placed in a
special subfolder in the Content Explorer (Resources\CHMSupport).

NOTE: If you import Microsoft Word documents containing embedded images into a project, Flare places copies of those image files in subfolders within the Resources > Images
folder. This is done in order to avoid naming conflicts with embedded images from other
Word documents that you might import. The subfolders are named after the Word documents being imported.
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CHAPTER 4

Project Organizer
The Project Organizer (along with the Content Explorer) is one of the most-used elements in the
Flare interface.
Just as it sounds, the Project Organizer contains and organizes all of your project-related files.
This chapter discusses the following:
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How to Open the Project Organizer
Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the View ribbon. In the Explorer section select Project Organizer.

n

Keyboard Shortcut Press CTRL+[ on your keyboard.
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What You Can Do in the Project Organizer
Following are the primary tasks that you can perform in the Project Organizer:
n

Auto Suggestion List Files (Add/Open) When you first start typing content in a topic, a popup
may display below your text as you type. This is the Auto Suggestion feature, which analyzes
text as you type and compares it to other content (e.g., phrases, variables, snippets) that
already exists in the project. This means you can quickly select existing content from the
popup so that you do not have to finish typing it.

n

Browse Sequences (Add/Open) If you have several topics that you think end users should
read in order, you can create browse sequences. When users view the compiled online Help
system, they can use your browse sequences to "browse" through topics in a particular order.

n

Conditions (Add/Open/Apply) A condition tag set is used to hold condition tags you create for
your project. A condition is something that you can apply to different areas of your content so
that some information displays in some of your outputs but not in others. You can create as
many condition tags as you want for a condition tag set. If you want more condition tag sets
to hold even more condition tags, you can easily add them. You can also expand the condition
tag sets in the Project Organizer to see the conditions within them. If you want to apply a condition to content, you can click and drag it from the Project Organizer to the content in the
XML Editor.

n

Context-sensitive Help—Alias Files (Add/Open) An alias file is used to populate a header file
with the information necessary for producing context-sensitive Help (CSH). In Flare, you can
open an alias file and use the Alias Editor to create and assign identifiers for the header file.

n

Context-sensitive Help—Header Files (Add/Open/Export) A header file is a simple text file that
contains basic information about connecting the dialogs or windows in a software application
to the corresponding topics in the Help system. Both you and the software developer need
access to this file.

n

DITA—Import File (Add/Open) A DITA import file is used to import DITA file content into a project.

n

Export File (Add/Open) An export file is used to export an entire Flare project, or parts of one,
to another location.

n

File Tag Sets (Add/Open) A file tag set is used to assign "tags" to topics and any other files in
Flare, even folders. You can use file tags for many different purposes, such as assigning
authors or milestones to topics. Flare lets you generate reports based on the tags that are
assigned. This makes project development easier to track, manage, and schedule.
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n

Flare Project—Import File (Add/Open) A Flare project import file is used to import Flare files
from other projects.

n

Folders (Create) When you add project files, they are added to various folders in the Project
Organizer. As your list of files grows, it may become somewhat difficult to find a specific file
when you want to work on it. In order to keep your files organized and easier to find, you can
create subfolders in the Project Organizer and move files into them.

n

FrameMaker—Import File (Add/Open) A FrameMaker import file is used to import
FrameMaker documents into a project.

n

Glossaries (Add/Open) A glossary is a feature that you can add to your output to help users
understand the meaning of individual terms.

n

Indexes—Auto-indexes (Add/Open) An auto-index lets you automatically add words and
phrases in your project to a generated index, rather than inserting the index markers manually. In the Project Organizer, you can add and open an auto-index phrase set.

n

Indexes—Link Sets (Add/Open) This is an index entry that links to another index entry. There
are three kinds of index links: "See," "See Also," and "Sort As." In the Project Organizer, you can
add and open an index link set.

n

Language Skins (Add/Open) Flare provides language skins for certain languages, such as
French, German, and Spanish (i.e., many values are already translated). These are languages
that are already identified as being "localized" skins. However, you can edit these default translations by creating a language skin for the language. For languages that do not provide default
translations, you can create language skins so that they can be applied to the output too.

n

Publishing Destinations (Add/Open) A publishing destination is a project file that contains the
information needed for publishing output (i.e., copying the files) to another location (such as a
website or a directory on your computer).

n

Relationship Tables (Add/Open) A relationship table is an element used to link related topics
together. It is similar to concept links or related topics links. Although a relationship table is a
common feature in DITA, you do not need to be using DITA or know anything about DITA in
order to take advantage of relationship tables.

n

Reports (Add/Open) In Flare you can generate custom reports based on the information contained in your project, for just about any type of information that the analysis tool captures. In
addition, you can design the look and feel of reports, save them for future access, and open
them in a browser window (where you can print them).

n

Search—Filter Sets (Add/Open) A search filter lets users narrow their search based on concepts that you have inserted into topics. Concepts are simply keyword markers that you insert
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into topics that have some kind of relationship with each other. They are also used for inserting concept links into topics (such as the "See Also" link that you see at the bottom of this
topic).
n

Search—Synonym Files (Add/Open) A synonym file lets you create synonyms for terms in your
project so that users are more likely to find the information they need when performing
searches.

n

Skins (Add/Open) A skin is a file that contains information about the appearance of the output
window.

n

Tables of Contents (Add/Open) In many cases, Flare provides you with an initial table of contents (TOC), which you further "build" (or create) using the TOC Editor. You can use this TOC
(or another one) as your primary, or "master," TOC. At some point, you may decide to add
another TOC to the project. The extra TOCs that you add can then be linked to the master
TOC.

n

Targets (Add/Open) A target is one "instance" of an output type. When you build your final output, you are essentially building one or more of the targets in your project. You can add regular
targets, as well as batch targets.

n

Variables (Add/Open/Insert) A variable set is an element used to hold one or more variables. A
variable is a pre-set term or content that you can use in your project over and over. Variables
are similar to snippets. There are different kinds of variables: (1) basic ones that you create,
(2) custom date/time variables that you create, (3) system variables (e.g., date and time;
titles; page count; Chapter, Section, and Volume numbers), (4) Heading variables, and (5) Running Head variables. Some of these are especially useful for page headers and footers in
print-based output. You can expand the variable sets in the Project Organizer to see the variables within them. If you want to insert a variable into a document, you can click and drag it
from the Project Organizer to the XML Editor.

n

Word—Import File (Add/Open) A Word import file is used to import Microsoft Word documents
into a project.

NOTE: You can also right-click on files in the Project Organizer and perform tasks from the
context menu that displays. For example, you can select "Open with" and open the selected
file in another application (e.g., Notepad).
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Navigation Buttons
Following are explanations of the navigation buttons in the Project Organizer:
Button/Section

Description
Lets you move the window pane from its docked position to another location in
the interface. Simply click on this area and drag the window pane to the new location.
Opens a drop-down menu with commands for moving and resizing the window
pane.
n

Close Closes the window pane.

n

Dock Attaches the window pane to the interface if it is floating.

n

Auto Hide "Pins" the window pane to the side of the interface so that you
have more room for your workspace. You can show the window pane by
hovering over the thin bar on the side of the interface. If you select this
option again, the window pane returns to its previous state (no longer
"pinned" to the side of the interface).

n

Float Detaches the window pane from the application so that it becomes
a free-floating element in the interface.

n

Standard Tabs (Top) Arranges window panes so that traditional tabs are
displayed at the top.

n

Standard Tabs (Bottom) Arranges window panes so that traditional tabs
are displayed at the bottom.

n

Accordion Tabs Arranges window panes so that they are stacked with
accordion tabs.

"Pins" the window pane to the side of the interface so that you have more room
for your workspace. You can show the window pane by hovering over the thin
bar on the side of the interface. If you select this option again, the window pane
returns to its previous state (no longer "pinned" to the side of the interface).
Closes the window pane.
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Buttons and Sections
Following are explanations of the different buttons and sections in the Project Organizer:
Button/Section

Description
Toggles between showing or hiding the folders in the Project Organizer.
Splits the Project Organizer into two halves. The right half shows additional
details for the files. When you click a file on the right side, a red circle shows the
location in the Project Organizer.
Expands all of the folders so that you can see all of the files under each one.
Collapses all of the folders so that you can no longer see all of the files under
each one.
Lets you show or hide the small squares next to each folder and file, which are
used to show colors representing condition tags that have been applied.
Moves up one folder in the hierarchy. This button becomes enabled if you use
the Split View button
view.

and select a file or folder on the right side of the split

Creates a new custom folder, which you can use to organize your files.
Displays the color of condition tags that are associated with the file (if any).
Condition tags are used to determine specific content or files to be included in
some targets but not in others.
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Button/Section

Description
n

Git and Subversion This indicates that the file has been modified. You can
commit the file when you are ready. If your project is bound to Subversion,
you can commit the file when you are ready (if you are the user who has
modified it, or if you have stolen the lock on the file from another user).

n

Perforce This indicates that the file has been checked out from source
control. You can submit the file when you are ready (if you are the user
who has checked it out).

n

TFS and VSS This indicates that the file has been checked out from
source control. You can check in the file when you are ready (if you are
the user who has checked it out).

You will see this icon for all source control providers.
This indicates that you have a file in your project but have not yet added it to the
integrated source control application. This might occur, for example, if you create a new topic and do not add the file to source control during the topic creation process. To resolve this, simply right-click on the file and select Source
Control > Add.
You will see this icon for all source control providers.
This indicates that the file is added to source control but is not currently
checked out, which means that it contains a "Read Only" designation in its properties. In order to edit the file, you must check it out from source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server or Perforce.
This indicates that another user has locked the file. You will often see this icon in
conjunction with the icon, indicating that another user is both using the file
and has locked the file. You can make changes to this file even if another user
has locked it.
If your project is bound to Subversion and you need to commit the file in while
another user is working on it, you can steal their lock. To do this, right-click on
the file and select Source Control > Lock. In the Lock dialog, select Steal the
lock, then click Lock.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
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Button/Section

Description
This indicates that you have locked the file. You will often see this icon in conjunction with the icon, indicating that you have both locked and modified the
file. Other users can make changes to this file even if you have locked it.
If your project is bound to Subversion, other users can steal your lock.
If you are using Team Foundation Server, you can lock a file when you check it
out.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, or Perforce, or Subversion.
n

Perforce and Subversion This indicates that the file is currently being modified by another user. You will often see this icon in conjunction with the
icon, indicating that another user is both using the file and has locked the
file.

n

TFS This indicates that the file is currently checked out to another user.
You can send a request to the user, asking that person to check in the file
so that you can check it out.

You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
This indicates that the file is not current (i.e., the local copy of the file is older
than the source control copy). This might happen if another user checks out the
file, makes changes to it, and checks it back in to source control. If this occurs,
you can check the file out or get the latest version of the file from source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server, Perforce, or Subversion.
This indicates that a file has been renamed, but not modified in any other way. If
you make any additional changes to the file, such as editing the text or adding a
condition tag, the renamed icon is replaced by a icon.
You will see this icon if your project is bound to Subversion.
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Button/Section

Description
This indicates that the file is deleted from source control, but you still have a
copy of the file on your local machine. If necessary, you can add the file to
source control.
You will see this icon if your project is bound to Microsoft Team
Foundation Server.

Advanced

Holds the various types of files after you add them to the project. These include
alias files, auto-index phrase sets, Auto Suggestion list files, browse sequences,
file tag sets, header files, index link sets, relationship tables, search filter sets,
and synonym files.

Conditional
Text

Holds the condition tag sets that you add to the project. You can expand the condition tag sets to see the conditions within them, and you can drag those conditions to content in the XML Editor.

Destinations

Holds the publishing destinations that you add to the project. Depending on the
project template you select, Flare may provide you with an initial destination
called "MyDestination."

Glossaries

Holds the glossaries that you add to the project. Flare provides you with an initial
glossary called "MyGlossary."

Exports

Holds export files that you add to the project. These are used to export your
Flare project (or parts of it) to another location.

Imports

Holds import files that you add to the project. This can include Flare project files,
Microsoft Word files, Adobe FrameMaker files, and DITA files. The Flare import
files have an .flimpfl extension, the Word import files have an .flimp extension,
the FrameMaker import files have an .flimpfm extension, and the DITA import
files have an .flimpdita extension.

Reports

Holds reports that you create in order to track information in your project. It also
holds error reports that you save after building output.

Skins

Holds the skins that you add to the project. There are two types of skins—Standard and HTML5.
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Button/Section

Description

Targets

Holds the targets that you add to the project. After you create a new project, you
will have only one target in this folder, based on your selection in the wizard.
However, you can add as many targets to a project as you need. In addition to
regular targets, you can add batch targets, which are used to generate multiple
targets in one batch.

TOCs

Holds the tables of contents that you add to the project. If a TOC has a green
arrow and the word "(Master)" after it, that means it is designated as the master
TOC. You can choose another TOC to be the master by right-clicking on it and
selecting Make Master TOC from the context menu.

Variables

Holds the variable sets that you add to the project. You can expand the variable
sets to see the variables within them, and you can drag those variables to content in the XML Editor.

[Preview Bar]

This is the area at the bottom of the Project Organizer. When you click on a file
or folder, this bar shows an icon, as well as the name of the folder or file.
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CHAPTER 5

XML Editor
The XML Editor is the primary editor. It displays when you open a content file from the Content
Explorer, and provides access to the underlying XML structure of documents in a comfortable visual
authoring environment. This editor is used to enter, modify, and format the content for topics that
users see in the output. Not only is this editor used for topics, but it is also used for working with master pages and snippets. Although this editor lets you produce XML files, you do not need to know anything about XML to use it.
This chapter discusses the following:
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How to Open the Editor
1. Open the Content Explorer.
2. Navigate to a topic, master page, or snippet.
3. Double-click the file that you want to open.
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Controlling How Content is Displayed
There are multiple layout modes that you can use when editing content files: Web Layout, Web Layout (tablet), Web Layout (mobile), and Print Layout.

These are necessary because Flare lets you create many different kinds of outputs from the same
content, and online output is usually meant to look much different than print-based output. The layout modes are designed to work alongside mediums and media queries, which you can also select in
the local toolbar of the XML Editor.
If your content doesn't look the way you expect it to in the XML Editor, it might have something to do
with these settings.

CHAPTER 5

47

Editing the XHTML Code
You don't need to know XHTML or HTML to work in Flare. The XML Editor displays content just as
you might expect to see it in an editor such as Microsoft Word. However, you can get behind the display to work in the actual code if you want. This is done in the Text Editor (or in another editor that
supports XML).
The XML Editor and the Text Editor are closely synchronized with each other. They can be shown in
a single window with options for viewing both at the same time and configuring their appearance.
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How to Use Split View
You can view the XML Editor and Text Editor in a docked state, where only one editor can be seen at
a time, but you can easily access the other editor by clicking on a tab. Alternatively, you can undock
the window and view both the XML Editor and Text Editor in a split view. Buttons allow you to switch
between a horizontal split view and a vertical split view.
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NOTE: You can also switch between the XML Editor and Text Editor by pressing CTRL+`
(grave accent) on your keyboard.
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Features of Split View
Not only does split view allow you to see the XML Editor and Text Editor jointly in different ways, but
there are also special features with split view.
n

Synchronization of Text
l

Highlighting text in one editor automatically highlights the related text in the other editor.
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l

Clicking in one editor causes the other editor to jump to the same position.

NOTE: If you highlight areas in the XML Editor that matches non-consecutive sections of XML, no highlight is shown in the Text Editor. For example, in the XML Editor,
you can highlight different parts of a table, but because of the order in which table
markup is written in XHTML, it cannot be similarly highlighted in the Text Editor.
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n

Code Validation If you type characters that result in invalid XML, the Text Editor displays an
error with information as to why the error exists.
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In addition, the following rules are in effect, depending on whether the editors are docked or
undocked.
l

l

n

If the editors are not docked (i.e., you can see the XML Editor), updates (i.e., highlights,
edits) stop going from the code to the XML Editor. If you make an edit in the XML Editor
while erroneous XML is in the Text Editor, the changes in the XML Editor take precedence
over any edits in the Text Editor.
If the editors are docked (i.e., you cannot see the XML Editor), you will be unable to start a
split view or click the XML Editor tab until the error is resolved.

Invalid Edits Outside of Flare If the document being viewed is edited outside of Flare with
invalid XML and saved, Flare will prompt you to open the file as text. If you select "Yes", the
editors remain open in split view, but the Text Editor becomes the main editor and the XML
Editor cannot be shown until the invalid code is fixed.
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Character and Symbol Entities in the Code
Although the code for Flare is HTML, remember that this is an XML editor that follows the W3C
XHTML Schema specification. Therefore, if you want or need to enter entities for characters and
symbols (e.g., via a third-party tool), you need to use the XHTML entity number.
After you add a valid entity into the Text Editor, it is converted to the actual character or symbol
after you switch to the XML Editor view and then back to the Text Editor view.
You can find a list of valid entity numbers for characters and symbols on the W3C website. See
http://www.w3.org/TR/html401/sgml/entities.html.
EXAMPLE
Let's say you are working in the code and want to add an en dash (—). To do so, you
would enter the following:
&#8211;
Do not enter &ndash; (because it is not valid XML).
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What You Can Do in the Editor
In addition to typing content, there are dozens of things you can do in the XML Editor. Following are
some of the primary tasks that you can perform.
n

Bookmarks (Insert/Edit) A bookmark is a marker, or flag, that lets you create hyperlinks to specific locations within topics (rather than to another topic file in general). You can insert a bookmark at a specific location in your topic (e.g., at a subheading) and then insert a hyperlink that
"connects" to that bookmark. This is a useful feature, for example, if you have a somewhat
lengthy topic and want the user to be able to locate a specific place in the topic quickly.

n

Characters and Symbols (Insert) You can insert special characters or symbols into
content. This can be done by using the Character dialog, by inserting a quick character that
you have specified, by selecting a favorite character, or by selecting a recent character.

n

Condition Tags (Apply) A condition is something that you can apply to different areas of your
content so that some information displays in some of your outputs but not in others.

n

Cross-References (Insert/Edit) A cross-reference is a dynamic navigation link that lets you
connect one topic to another (or a bookmark within a topic). This is somewhat similar to a
text hyperlink. However, cross-references differ from hyperlinks in a few ways. (1) They are
based on format commands that help you keep the look of links consistent. (2) They are especially useful for print output because they let you automatically refer to specific areas and/or
page numbers in the output. (3) Both the source and destination files must be part of the
same target output within the same project.

n

Drop-Down Text (Insert/Edit) Drop-down text is a feature that lets users click a hotspot to
expand and collapse specified content below it. Let's say you have a topic that seems to be
getting quite lengthy. So you decide to condense the portion of the topic that contains stepby-step procedures. When users open the topic in the output, they will see a link (also called a
"drop-down hotspot"). This hotspot is the first paragraph (or a section of the first paragraph)
that you condensed. It might be something like "How to create a project." When users click
that hotspot, the hidden content (e.g., the actual steps to create the project) is displayed
below the hotspot. When users click the hotspot again, the content becomes hidden once
more.

n

Equations (Insert/Edit) From any location in a topic or snippet you can insert an equation.
Although an equation may be composed of many different parts, in the XML Editor it renders
as a single block of content. In that way, it behaves much like an image.
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n

Expanding Text (Insert/Edit) Expanding text is a feature that lets users click a hotspot to
expand and collapse content that appears after it in the same paragraph or other block element. Let's say you have a bulleted list in a topic. After each bullet is a feature of the software
program that you are explaining. You have given a detailed description of each feature, and
now the topic seems to be getting quite lengthy. So you decide to condense each bulleted
item so that users initially see only the name of the feature, which appears as a link (also
called an "expanding text hotspot"). When users click that hotspot, the hidden content (i.e.,
the rest of the paragraph) "expands" and is displayed after the hotspot. When users click the
hotspot again, the content becomes hidden once more.

n

Formatting—Local (Apply) When you edit the content of a topic, you are working in the XML
Editor. Local formatting is a way to change the look and feel of content directly so that the
changes are applied only to that specific content (as opposed to applying the changes
throughout your project via the use of styles). However, using styles is recommended instead
of local formatting when possible.

n

Hyperlinks (Insert/Edit) A text hyperlink is one of the most basic forms of a navigation link. It is
simply a hyperlink applied to text. When an end user clicks the hyperlink in the output, the location specified in the hyperlink opens. The location can be another topic in the project (including a bookmark within that topic), a topic in an imported HTML Help file, or a file outside of the
project (such as a website on the Internet).

n

Images (Insert/Edit) You can insert images into content files (e.g., topics, snippets). Flare supports the following types of raster and vector image files: BMP, EMF, EPS, EXPS, GIF, HDP,
JPG, JPEG, PDF, PNG, PS, SVG, SWF, TIF, TIFF, WDP, WMF, XAML, XPS.

n

Index Keywords (Insert/Edit) Unlike some features in Flare, there is no independent index file
in your project that becomes the index in your output. Instead, the index is automatically generated when you build output, based on index keywords that you insert into content files in
your project.

n

Keyword Links (Insert/Edit) A keyword link is a Help control that lets users open topics related
to the current topic based on index keywords that they share.

n

Locate in Content Explorer If you have a content file open in the XML Editor and want to
quickly find where it is stored in the Content Explorer, you can right-click in the file and select
Locate in Explorer. Flare opens the Content Explorer, expanding folders to show where the file
is located.

n

Locate in TOC If you have a topic open in the XML Editor and want to quickly find where it is
linked in a table of contents, you can right-click in the file and select Locate in TOC. If the
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topic is located in more than one TOC, a dialog opens, listing all of those TOCs. Select the
TOC you want to look in and click Open.
n

Micro Content (Create) Micro content is what it sounds like—short, concise information that
stands alone and is easily consumable. In Flare, it begins with the creation of a collection of
brief phrases and corresponding responses, such as questions and answers. After generating
HTML5 output, these phrase/response combinations can be used in different ways as users
interact with your output. Among other benefits, it can greatly improve the user experience
when people search in your HTML5 output.

n

Multimedia (Insert/Edit) Not only can you explain concepts and tasks to users in your project,
but you can also show and tell them through the use of multimedia (video and audio). You can
insert links to YouTube and Vimeo movies; files such as Flash, Windows Media, and Quicktime;
MadCap Mimic video files; and 3D models.

n

Popups (Insert/Edit) A text popup is a link that opens a popup box containing basic text that
you provide. A topic popup is a text hyperlink that opens a topic or external file (such as a website) in a popup box.

n

Preview You can quickly see how a topic (as well as a snippet or master page) will look in the
final output by previewing it. The Preview window pane is dynamic, allowing you to keep the
preview open while you work and see changes as you make them in the XML Editor.

n

Proxies (Insert) A proxy acts as a placeholder for auto-generated content or content that you
have created elsewhere. When you build output, the content takes the place of that proxy.
Proxies can be added to regular topics, as well as to master pages. The difference is that a
proxy added to a topic will display that information in the output only once (wherever the topic
occurs), but if a proxy is added to a master page, the content will show up everywhere that
the master page has been applied. Proxies are quite often used for print-based outputs, especially to create navigation-like elements, such as TOCs, indexes, and glossaries. However,
proxies can be used in online output as well. They can be especially useful if you are creating
HTML5 Top Navigation output, where the traditional tripane format is replaced by a more
modern design that relies heavily on proxies.

n

QR Codes (Insert/Edit) You can insert a quick response (QR) code into a content file (e.g.,
topic, snippet) using the XML Editor. A QR code is a type of barcode that can be read by
devices such as smart phones. The data encoded in the QR code can be text, a website URL,
an email address, contact information, or SMS (Short Message Service, which is used for
sending text messages). Basically, QR codes are a way to bridge the gap between a static
print document and searchable, more detailed online information at your fingertips
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n

Related Topics Links (Insert/Edit) A related topics link is a Help control that provides users
with list of links to topics that you've specified as being related to the current topic. This is similar to a concept link. You might use a related topics link if you are applying it to a topic that
you want to associate with specific topics but you do not plan to reuse the same link in other
topics.

n

Responsive Layouts (Create/Edit) Styles and media queries can be used to make your content responsive in HTML5 output. This lets you present information—both its substance and
structure—differently depending on the size of the screen or device. Flare provides a Responsive Layout window pane that helps you create this kind of content more easily. You also have
the option of using third-party solutions (most notably the Zurb Foundation grid system) by
adding the appropriate styles in your stylesheets and topics.

n

See Also (Concept) Links (Insert/Edit) A concept link is a Help control that lets users open topics that you've determined are related to the current topic. It is similar to the related topics
link. However, whereas you associate a related topics link with specific individual topics (usually for a one-time use), you associate a concept link with a group of topics (to be reused in different topics). One great benefit of this type of link is that, if you later want to add or delete
topics from the group, you only need to do so in one place and the changes are applied to
every topic containing that concept link.

n

Slideshows (Insert/Edit) You can add a slideshow as an alternative way to display content,
using navigation controls to move from slide to slide to view different content. Most kinds of
content can be placed into a slideshow, including snippets, text, tables, and more.

n

Snippets (Create/Insert/Edit) A snippet is a file that is sort of like a miniature topic. You can
insert and format text, tables, images, and whatever else can be included in a normal topic. A
snippet can be inserted into one or more topics throughout your project, thus allowing you to
reuse content that is maintained in one place. You can even insert them into other snippets,
creating nested snippets. We’re not usually talking about single words or phrases; that’s what
variables are for.

n

Styles (Apply) If you are using styles in your project, you can change the look of content
simply by applying styles to it.

n

Tables (Insert/Edit) A table in Flare is much like it is in any word processing program, such as
Microsoft Word, or in a printed textbook. It is a group of intersecting columns and rows that
you can add to a topic for various purposes, such as comparing different elements.

n

Togglers (Insert/Edit) A toggler is a feature that lets users click a hotspot to reveal one or
more named elements in a topic. A named element (also called the "toggler target") is a chunk
of content that can reside anywhere in the topic. When users click the toggler hotspot, the
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output reveals hidden content elements. When users click the hotspot again, the content is
hidden again.
n

Variables (Insert) A variable is a brief, non-formatted piece of content that can be edited in
one place but used in many places throughout your project. They're especially good for text
that might change frequently, such as version numbers and dates. Variables are stored in variable sets, which can hold multiple variables. Depending on the template you select when creating a project, Flare may provide you with an initial variable set, but you can add as many
additional variable sets and variables as you like. There are different kinds of variables: (1)
basic ones that you create, (2) custom date/time variables that you create, (3) system variables (e.g., date and time; titles; page count; Chapter, Section, and Volume numbers), (4)
Heading variables, and (5) Running Head variables. Some of these are especially useful for
page headers and footers in print-based output.
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Repeat Last Action
When you are working in the XML Editor, you can use the F8 shortcut to repeat your last action. This
feature uses the same controller that is used when you create macros in Flare. Therefore, only
actions that are supported by the macro controller are supported for the repeat shortcut.
EXAMPLE
Let’s say you are in a topic where you need to apply a span style class to several words
to change the text to blue. You highlight the first word and apply that style class using
the Styles window pane. But instead of following those same steps to format all the
other words, you use the repeat shortcut. You highlight the next word that needs to be
blue and press F8. The blue span style class is applied to that word. You highlight the
next word and press F8 again. Once more, the blue span style class is applied. You continue doing this until all the appropriate words have that style class applied.
Next, you realize that you need to turn several paragraphs in the topic into drop-downs.
So you select the first group of relevant paragraphs and select Insert > Drop-Town Text
to create a drop-down effect. You highlight the next group of relevant paragraphs, but
instead of using the option in the Insert ribbon again, you press F8. The drop-down
effect is applied to those paragraphs. You continue to use the F8 shortcut until all the
necessary content in the topic is turned into drop-downs.

TIP: If you prefer to use a shortcut other than F8 for this feature, you can open the Options
dialog (File > Options), select the Keyboard Shortcuts tab, choose XML Editor in the top
field, and assign the Repeat action to a different key.

NOTE: Although you can only repeat an action if that action is supported by the macro controller, you do not need to have assigned a macro to your action in order to repeat it. This
allows you to repeat occasional actions without having to spend time recording a macro.
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Buttons and Sections—Top of Editor
Following are explanations of the different buttons and sections at the top of the XML Editor.
Button/Section

Description
This button lets you preview the topic, snippet, or master page. It also lets you
see how the topic will look with condition tags associated with it or with specific target settings applied to it. If you click the face of the button, the preview
is shown based on the format specified in the primary target. If you click the
down arrow, you can select any of the targets in your project from a menu. The
preview is then displayed using the output format specified in that target.
In addition, the preview updates as you save changes in your file; when you
open a new content file (i.e., topic, snippet, master page); when you change
the File, Target, or Conditional Expression fields; and when you click the refresh
button
.This ensures you are always seeing the most current content in the
Preview window pane.

NOTE: The topic preview feature is not available for Microsoft Word
formats.

Opens the Conditional Text dialog, which lets you associate condition tags with
a file while you edit it. This is similar to the feature that you can use to preview
a document with certain conditions set. The difference is that this associates
the conditions to the document as you edit it in the XML Editor.
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Button/Section

Description
Flare provides multiple layout modes when working in the XML Editor: Web Layout, Web Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you
see your content in the format that you are most likely concerned about at the
moment.
The default and print mediums are tied to the Web Layout and Print Layout
modes, respectively. The tablet and mobile media queries are tied to the Web
Layout (Tablet) and Web Layout (Mobile) modes, respectively.

EXAMPLE
You are using the Web Layout mode, so the XML Editor displays
the styles from the default medium. But if you switch to Print Layout mode, the XML Editor automatically displays the styles from
the print medium. And if you choose the Web Layout (mobile)
mode, the XML Editor adjusts to show the topic as if it were displayed on a mobile device.
The key is to select the layout first. If you select the medium or media query,
the layout will not automatically change as well.
Clicking this button lets you toggle between layout modes:
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n

Web Layout This is useful for seeing how the topic will look online, usually
on a laptop or a large monitor.

n

Web Layout (Tablet) This is useful for seeing how the topic will look on a
tablet device.

n

Web Layout (Mobile) This is useful for seeing how the topic will look on a
mobile device.

n

Print Layout This lets you see how the pages will look with a page layout
applied to it. In other words, it lets you see how the page will look when
you generate print-based output. This means that you will be able to view
the actual page size and orientation, as well as the margins and any
header or footer content.
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Button/Section

Description

NOTE: Although the Print Layout mode is a WYSIWYG (What
You See Is What You Get) environment, you also need to consider any condition tags when you are viewing pages in this
mode. For example, let's say you have applied a condition tag to
an entire paragraph on a page. When you are viewing the topic in
the XML Editor, you will see this paragraph, but if you generate a
target where you have elected to exclude that condition tag, the
paragraph will not be displayed in the output, and the other paragraphs will shift to compensate for its absence. Therefore, what
you see in the Print Layout mode is what you get, except possibly for certain conditions that may be present on a page.
You can get an even more accurate look at how a topic will look
in the output by associating conditions with it while you are editing. This is similar to the feature that you can use to preview a
document with certain conditions set. The difference is that this
associates the conditions to the document as you edit it in the
XML Editor.

n

Edit Page Layout Document This opens the page layout associated with
the topic so that you can edit it in the Page Layout Editor.

n

Edit Master Stylesheet This opens the stylesheet associated with the
topic so that you can edit it in the Stylesheet Editor.

NOTE: This option is available only if you have applied a master
stylesheet to the project or target.
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Button/Section

Description
Clicking the down arrow on this button lets you select a medium or media
query so that you can view the topic with a specific set of styles.

MORE INFORMATION
A medium is an alternative group of settings in a stylesheet and can be very
useful when you are generating multiple kinds of outputs. Unless you tell Flare
otherwise, default style settings will be used for the different outputs you generate. But there may be times when you want to override a default style setting
for a particular output; that's why you would use a medium. You need to explicitly tell Flare which medium you want a particular target to use. This is done
from the Advanced tab of the Stylesheet Editor.
A media query is an alternative group of settings in a stylesheet. These settings are automatically used under certain conditions, such as when a screen
of a certain size is displaying the output. Media queries are able to do this
because they are configured with specific criteria (e.g., maximum width of the
screen, orientation, resolution). When the criteria are met, the style settings in
the media query are used to display the output. You do not tell a Flare target to
use a media query; it just happens automatically.
This drop-down field is simply intended to show you how particular styles make
a topic look. By using this feature, you are not telling Flare to use that medium
in the output for that topic. The way to do that is to associate the medium with
a target.
If you are viewing content using the Print Layout in the XML Editor, you can use
another drop-down in the local toolbar to choose a specific page layout. Not
only can you select a certain page layout to display a topic in the XML Editor,
but you can also choose a specific page type within that layout. This can be
especially useful when you know for certain that a particular topic will display
on the first page of a chapter, a left page, a right page, etc. The reason Flare
does not automatically show a topic in the appropriate page type is because it
won't assign page types to content until you generate the output. However,
sometimes you may know in advance which page type will be used because of
its placement in the outline TOC, so you can choose any page type contained
in the layout to display the topic in the XML Editor.
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Button/Section

Description
Opens the Insert Hyperlink dialog, which lets you insert a text hyperlink on the
selected text in the topic.
Opens the Insert Cross-Reference dialog, which lets you insert a cross-reference into the topic at the location of the cursor.
Opens a dialog, if you click the face of the button. You can use this dialog to
insert an image. If you click the down arrow on the button, a drop-down opens,
where you can access your pinned images and recently used images.
Opens the Insert Snippet Link dialog, if you click the face of the button. You
can use this dialog to insert a snippet. If you click the down arrow on the button, the Insert Snippet drop-down opens, where you can access your pinned
snippets and recently used snippets.
Opens the Variables dialog, if you click the face of the button. You can use this
dialog to insert a variable. If you click the down arrow on the button, a dropdown opens, where you can access your pinned variables and recently used
variables.
Opens the Character dialog, if you click the face of the button. You can use this
dialog to choose a character to insert or perform many other tasks. If you click
the down arrow on the button, you can select other options, such as inserting a
quick character or choosing one of your favorite or recent characters.
Activates Index Entry Mode. Use this method to accomplish the same thing as
the Index window pane method. The difference is that, with this method, you
do not need to move your cursor from the topic or snippet to the Index window
pane. You simply click at the spot in the text where you want to insert the
keyword and start typing. The words you type are added directly into the Index
window pane. This is a good method to use if you plan to do a lot of indexing all
at once, without performing any other tasks in the topic or snippet.
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Button/Section

Description
Activates Concept Entry Mode. Use this method to accomplish the same thing
as the Concept window pane method. The difference is that, with this method,
you do not need to move your cursor from the topic to the Concept window
pane. You simply click at the spot in the text where you want to insert the
keyword and start typing. The words you type are added directly into the
Concept window pane. This is a good method to use if you plan to create concepts in a lot of topics all at once, without performing any other tasks in the
topic.
Turns paragraph and space markers on and off. When you turn this feature on,
you can see markers that show where paragraphs end and where space exists
before and after content.
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Button/Section

Description
If you click the face of this button, all of the content changes, showing the XML
tags surrounding the content. If you click the down arrow, you can select the
following options.
n

Show Caret Tag Neighborhood Turns this feature on and off (it is off by
default). If you click on a line that contains inline tags (e.g., bold font,
cross-reference), floating tag bars display above it (this is called the
"caret tag neighborhood"). You can click on a bar to open the context
menu and take action on the content.

n

Show Markers Turns markers on or off in the active topic or other content file. If you have inserted elements such as variables, bookmarks,
index keywords, or concepts into topics, markers indicate where they
have been added. If the "Markers" option is turned off, you cannot
determine whether such elements have been added. Turning the "Markers" on, lets you see exactly what has been inserted into the file. Markers
appear in different ways, depending on the type of element inserted. For
example, variable markers display as brackets around the variable
information, whereas bookmark markers display as shaded flags where
the bookmark has been inserted.

n

Show Inline Markers You can show or hide markers for all inline elements in the active topic. You might find this feature useful if you have
imported DITA file content. The reason for this is that DITA inline tags
are often for semantic purposes, rather than for changing the look of
content. By enabling the inline markers feature, it is easy to tell when particular content is using a tag.

NOTE: In order to use this feature, you must also make sure that
Show Markers is turned on.
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n

Show invisible tags Turns invisible tags (e.g., <title>) on or off in the active topic. This option is enabled only if you have selected "Show tags."

n

Show Comments Turns comment tags on or off in the active topic. Comment tags are those that you have added to a topic in order include
notes behind the scenes (without the comments being seen in the output).
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Button/Section
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Description
n

Show All Images As Thumbnails Toggles between showing images in
the XML Editor as thumbnails or at full size. This is simply a feature for
you as the author, allowing you to scale all images down to 48 pixels high
(if the original size is larger than that). This lets you see more content
and less of your images as you edit topics. The images are only scaled
for your editing purposes; they are not shown as thumbnails in the output.

n

Show tags in mono-color Lets you choose whether to display tags in a
color or in black. This option is enabled only if you have selected "Show
tags."

n

Show tags in mono-font Lets you choose whether to display all tags in
the same font or in the font actually applied to each area. This option is
enabled only if you have selected "Show tags."

n

Enable Object Positioning Turns object positioning on and off. Object
positioning can be used with text boxes, images, and other objects that
you have inserted into topics. If this option is on, you can easily position
the object in different places in the topic (e.g., to the right or left of the
frame on a page).

n

Enable Orphan/Widow Control Turns widow and orphan control on or
off. If this is turned on, you can see the effects in the Print Layout mode
in the XML Editor. Widow control determines the minimum number of
lines in a paragraph to be left at the top of a page or column. Orphan control determines the minimum number of lines in a paragraph to be left at
the bottom of a page or column. The default number of lines for both is
2, but you can adjust this setting.

n

Show Hidden Elements Shows content that has been designated as "hidden." In other words, you can have a style where the "display" property
value is set to "none." Normally, content to which this style is applied will
not be seen. But you can display that content by selecting this option.

n

Conditional Indicators If you have created and applied condition tags,
clicking this button toggles between showing and hiding them.

n

Snippet Conditional Indicators If you have created and applied snippet
condition tags, this command enables or disables a marker that overlays
snippets that have snippet conditions applied to them.
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Button/Section

Description
n

Show Variable Names Lets you choose whether to see the names of
variables in your markers (if you have inserted variables) in the active
topic.

n

Show Bookmark Names Lets you choose whether to see the names of
bookmarks in your markers (if you have inserted bookmarks) in the active topic.

n

Show Named Elements Lets you choose whether to see the yellow flag
icon next to named elements in your markers (if you have inserted
named elements) in the active topic. Named elements are used for
inserting togglers into topics.

n

Enable/Disable Locks Locks or unlocks the content designated with the
gray background. After content has been locked, it cannot be edited, and
annotations cannot be added to it.

n

Show Locked Elements Allows you to show or hide the gray background
associated with elements that have been locked or selected to be
locked.

n

Show Changes Displays any tracked changes or annotations (notes)
that have been attached to any content in the topic.

n

Marker Width Lets you adjust the width of markers in the active topic to
see more or less of the markers when they are visible.

Opens the file in the Internal Text Editor (for review packages only).
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Buttons and Sections—Bottom of Editor in
Web Layout Mode
Following are explanations of the different buttons and sections at the bottom of the XML Editor
when you are working in Web Layout Mode.
Button/Section
Words

Description
Displays the number of words in the open file. If you highlight words in the
file, this area shows you how many words are selected out of the total count.
If a file contains snippets, the words from those snippets are not included in
this word count, because those are separate files.
Reduces the scale of the font by 10% each time you click the button.
Resets the scale of the font to 100%.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font.
Lets you show or hide the colored shading of content to which condition tags
have been applied.

EXAMPLE
Let's say your condition tag has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one condition
tag is applied to the block of content, the shading appears in a
pattern that shows all of the applied condition tag colors.
Lets you show or hide the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of content,
as well as the overall tag structure.
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Button/Section

Description
Lets you show or hide the span bars. These bars are displayed at the top of
the content area. They show formatting tags in your content.

EXAMPLE
If you have a block of text that is bold and you click it, you will
see a "b" in a bar above.
Lets you show or hide a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, or inches.
Lets you show or hide a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select to convert the ruler to pixels, points, centimeters, or inches.
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Buttons and Sections—Bottom of Editor in
Print Layout Mode
Following are explanations of the different buttons and sections at the bottom of the XML Editor
when you are working in Print Layout Mode.
Button/Section
Words

Description
Displays the number of words in the open file. If you highlight words in the
file, this area shows you how many words are selected out of the total count.
If a file contains snippets, the words from those snippets are not included in
this word count, because those are separate files.
Displays the first page of the topic in Print Layout mode.
Displays the previous page of the topic in Print Layout mode.
Displays the next page of the topic in Print Layout mode.
Displays the last page of the topic in Print Layout mode.
Displays the current page of the topic, as well as the total number of pages in
the topic. You can enter another number in the field or use the arrow buttons
to navigate to a different page.
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Button/Section

Description
The Zoom/Scale button (which looks different depending on the current
selection) opens a drop-down menu so that you can select from the following options:
n

100% Displays the page at 100% of its actual size.

n

100% (2 pages) Shows two pages of a topic at a time, displaying each
one at 100%.

n

Fit Width Resizes the page so that it displays in proportion to the width of
the window pane.

n

One Page Displays only one page at a time.

n

Two Pages Displays two pages at a time.

n

Four Pages Displays three pages at a time.

n

Eight Pages Displays four pages at a time.

NOTE: This option is available only if you are working in Print Layout
mode. In this mode, additional pages are automatically created
when you add content beyond that which can be held on a single
page.

Reduces the scale of the font by 10% each time you click the button.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font.

CHAPTER 5

76

Button/Section

Description
Lets you show or hide the colored shading of content to which condition tags
have been applied.

EXAMPLE
Let's say your condition tag has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one condition
tag is applied to the block of content, the shading appears in a
pattern that shows all of the applied condition tag colors.
Lets you show or hide the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of content,
as well as the overall tag structure.
Lets you show or hide the span bars. These bars are displayed at the top of
the content area. They show formatting tags in your content.

EXAMPLE
If you have a block of text that is bold and you click it, you will
see a "b" in a bar above.
Lets you show or hide a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, or inches.
Lets you show or hide a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select to convert the ruler to pixels, points, centimeters, or inches.
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Elements in Editing Area
Following are explanations of various elements that you may see in the editing area.
Button/Section
Structure Bars

Description
These are just what the name implies—bars around the topic content that
show the structure. There are two kinds of structure bars—tag and span.
Not only do structure bars let you see the tags for content, but you can also perform numerous tasks by using them.
n

Select Options If you right-click on a structure bar, a context menu
opens. From the menu, you can select from several options to take
action on the content associated with that structure bar.

n

Select Content If you left-click on a structure bar, the corresponding content is selected in the editor.
You can SHIFT-click on structure bars to extend the current selection to
that content block.
If you select multiple blocks of content, all of the structure bars involved
in that selection are highlighted in blue. If an entire block is included in
the selection, the structure bar is shaded in darker blue. If blocks are partially selected, those structure bars are shaded in lighter blue.

n

Markers

Move Tag Bars If you left-click on tag bars, you can drag them up or
down. If you left-click on table column bars (in the span bar area), you
can drag them left or right. In this way, the chunks of topic content can
easily be repositioned. In addition, you can click on the borders between
column and row bars and drag the mouse to resize individual columns
and rows.

A marker is a highlighted "flag" that shows the insertion of certain features. For
example, if you insert a variable, bookmark, or index keyword, a marker indicates where that feature has been inserted. You can adjust marker widths or
turn them off or on by using the "Show tags"
button in the local toolbar.
(Despite the name of this button, it does not display the "true code" in the topic.
It shows the high-level tags and the tag markers.)
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Button/Section
Cursors

Description
When you edit text, the cursor changes size and shape. Sometimes it contains
brackets to the right or left. Sometimes it is larger, and sometimes it is smaller.
Each of these appearances serves a different purpose.
Following are explanations of these cursors.
n

Tag Start
Cursor signifies the start of an xhtml tag.

n

Tag Middle
Cursor signifies you are within an xhtml tag and can edit the contents.

n

Tag End
Cursor signifies the end of an xhtml tag.

n

Tag Between
Cursor signifies you are between tags. Type to enter text into the parent
tag.

n

Tag Before - Level 1
Cursor size signifies you are in the first of a series of nested tags.

n

Tag Before - level 2
Cursor size signifies you are in the second of a series of nested tags.

CHAPTER 5

79

Button/Section

Description

n

Tag Before - Level 3
Cursor size signifies you are in the third of a series of nested tags.

Some content Courtesy of TechWriteTips.
Caret Tag Neigh- The interface includes a "caret tag neighborhood." If you click on a line that conborhood
tains inline tags (e.g., bold font, cross-reference), floating tag bars display
above it. You can click on a bar to open the context menu and take action on
the content.
This feature is disabled by default. If you want to turn it on, simply click the
down arrow in the editor's Show Tags button
Neighborhood.
Empty Tags

and select Show Caret Tag

If you are working in a document in the XML Editor and have empty tags at the
text level, this will be shown.

NOTE: The display of empty tags is simply designed to help you as you
edit content. Even if these tags are shown in the XML Editor when you
are working, they will not be shown in your output.
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Button/Section

Description

Auto Suggestion

When you first start typing content, a popup may display below your text as you
type. This is the Auto Suggestion feature, which analyzes text as you type and
compares it to other content (e.g., phrases, variables, snippets) that already
exists in the project, like this:
This means you can quickly select existing content from the popup so that you
do not have to finish typing it.
By default, Auto Suggestion is enabled when you first launch Flare. However,
you can disable and enable this feature whenever you want.
There are three kinds of content that you can select when using Auto Suggestion: phrases from custom lists, variables, snippets.
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n

Phrases From Custom List Rather than automatically basing auto suggestions on all of the text throughout your entire project, you have control over the phrases that you see in the popup when you type. You can
add your own words and phrases to an auto suggestions list. That way,
instead of being overwhelmed with too many suggestions every time you
begin typing text, you only see suggestions that you are likely to use.

n

Variables Flare recognizes when you are typing content that matches
existing variables in your project. This includes system variables, such as
the date and time, and custom variables that you create.

n

Snippets Flare recognizes when you are typing content that matches
existing snippets in your project. This makes it a very fast and convenient
way to single-source your content.

81

Button/Section
Icons for Page
and Column
Breaks

Description
If you are working on a document in the Print Layout mode, you may see icons
in the margins next to text. These icons indicate where a paragraph has been
moved to another page or column as a result of a page or column break, or due
to widow or orphan control. You can set page breaks, column breaks, orphan
control, or widow control either manually on individual paragraphs or you can
set them on styles. You can click on any of the icons in the document to open
the paragraph properties.
Following are the types of icons that you might see in a document.
Explicit Page Break This icon displays if you have created a page break
before a paragraph.
Explicit Page Break by Previous This icon displays if you have created a
page break after a paragraph.
Explicit Column Break This icon displays if you have created a column
break before a paragraph.
Explicit Column Break by Previous This icon displays if you have created
a column break after a paragraph.
Orphan Controlled This icon displays if a paragraph has been adjusted
due to orphan control.
Widow Controlled This icon displays if a paragraph has been adjusted
due to widow control.

Page Count for
Print Layout

CHAPTER 5

If you are using the Print Layout view in the XML Editor and the topic contains
more than one page of content, a label appears beside the scroll bar indicating
the current page.
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CHAPTER 6

Stylesheet Editor
The Stylesheet Editor displays when you open a stylesheet file from the Content Explorer, and is
used to modify styles contained in regular stylesheets. For special table stylesheets, you will use the
Table Style Editor. However, you can also use the Stylesheet Editor to modify standard HTML table
tags (e.g., th, td) that are contained within a regular stylesheet.
This chapter discusses the following:
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Two Views
There are two views available in the Stylesheet Editor: Simplified and Advanced. You can toggle
between these two views by clicking
editor.
n

or

in the local toolbar of the

Simplified The Simplified view displays styles in a grid view and is often best for brand new
users.
This view provides an easy way to apply properties to styles, with format options available from
a toolbar and dialogs (similar to the way one would use an interface such as Microsoft Word). In
some cases, only the most common property options are available in the Simplified view (e.g.,
font, letter/word spacing, paragraph alignment/indentation, autonumbering format, borders,
background). One advantage of the Simplified view is that you can apply a property to multiple
styles at the same time. You can also click a check box to hide the properties in the editor,
allowing you to see only the styles.

n

Advanced The Advanced view displays styles in a tree structure, and despite the name, is user
friendly for authors of all levels.
For the properties, you can toggle between a grouped display and an alphabetical display. The
Advanced view of the Stylesheet Editor allows you to edit more settings than are available in
the Simplified view. In addition, the Advanced view lets you see and apply settings to multiple
mediums and media queries at the same time.

CHAPTER 6

84

How to Open the Editor
1. Open the Content Explorer.
2. Locate and double-click a stylesheet (CSS) file.
If you used the default location when you added the stylesheet to the project, the stylesheet is
located in the Resources > Stylesheets subfolder of the Content Explorer.
If you imported the stylesheet from another authoring tool, the stylesheet is located in the
same subfolder (if any) where it was stored in the source project, or at the root level of the
Content Explorer.
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What You Can Do in the Stylesheet Editor
You can accomplish many things in this editor. Some of the primary tasks that you can perform are
listed below:
n

Comments (Add) If you are familiar with using cascading stylesheets (CSS) in a text editor,
you probably already know that you can add comments to styles. This is simply a way to
remind you or others about information related to a style (e.g., which situations are appropriate to use a certain style). In Flare you can add, edit, and view these style comments
through the user interface.

n

Font Sets (Manage) If you have added more than one stylesheet to your project, you can link
them together. By doing this, one stylesheet can adopt the styles of the other stylesheet so
that they can be used in topics where that stylesheet is applied.

n

Media Queries (Create) A media query is an alternative group of settings in a stylesheet.
These settings are automatically used under certain conditions, such as when a screen of a
certain size is displaying the output. Media queries are able to do this because they are configured with specific criteria (e.g., maximum width of the screen, orientation, resolution).
When the criteria are met, the style settings in the media query are used to display the output.
You do not tell a Flare target to use a media query; it just happens automatically.

n

Mediums (Create) A medium is an alternative group of settings in a stylesheet and can be
very useful when you are generating multiple kinds of outputs. Unless you tell Flare otherwise,
default style settings will be used for the different outputs you generate. But there may be
times when you want to override a default style setting for a particular output; that's why you
would use a medium. You need to explicitly tell Flare which medium you want a particular target to use. This is done from the Advanced tab of the Stylesheet Editor.

n

Selectors (Create) A selector is a way to associate HTML content with style settings based on
various information—most often its type, class, or ID. Sometimes the word "selector" is used
interchangeably with the term "style," but a selector can be much more than just a simple
style. When you create a new stylesheet, it already has many selectors in it. If necessary, you
can create new selectors of varying levels of complexity.

n

Selectors (Rename) You can rename a selector (e.g., class, ID) after you have created it.
However, you cannot rename existing parent styles, such as p, h1, or span. When you rename
a style class or ID, you have the option to automatically rename all instances of that class or
ID in the stylesheet accordingly.
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n

Style Property Values (Cut, Copy, Paste) In both the Stylesheet Editor and Formatting window
pane, you can display properties in alphabetical view, as opposed to grouped view. When you
are in alphabetical view, you can select multiple properties for a particular selector. Then you
can cut/copy and paste these properties into another selector; they can also be pasted in the
Stylesheet Editor or in a text-based editor, such as Notepad or the Internal Text Editor. Declarations can also be copied from a separate CSS document and into your stylesheet in Flare.

n

Style Property Values (Delete) In addition to copy, cut, and paste, you can also delete the values for those properties from the current selector.

n

Styles (Disable) You can prevent certain styles from being shown in the Stylesheet Editor and
in the Flare interface. This is a good feature if you use only some of the styles provided in a
stylesheet. Rather than being overwhelmed with the sight of all styles in the stylesheet, you
can ensure that you see only the styles that you tend to use in your project. Those styles will
not be removed from the stylesheet; they will simply be hidden until you enable them.

n

Styles (Edit) After you create a new regular stylesheet, you can edit the styles within it.

n

Styles (Import) You can manually create new styles in a stylesheet. Another option is to
import existing styles from another stylesheet.

n

Stylesheets (Link) If you have added more than one stylesheet to your project, you can link
them together. By doing this, one stylesheet can adopt the styles of the other stylesheet so
that they can be used in topics where that stylesheet is applied.
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Why are Some Styles Gray?
When making changes to styles in the Advanced view of the Stylesheet Editor, you may notice that
some styles are gray. These are called "inherited" styles. That's because they do not yet have explicit settings on them, so they are inheriting default values from somewhere else (e.g., a factory
stylesheet located where you installed the application). As soon as you make a change to one of
these styles, it ceases to be an inherited style (or at least the property you set is no longer inheriting
from the default value), and the style name turns from gray to a darker font. You can click Hide
Inherited in the local toolbar if you want to hide these inherited styles.
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Also, if you hover over an inherited style, Flare displays the path to the stylesheet from which the
style is inherited.

If you have created a link from one stylesheet to another, you can double-click on an inherited property to open that other stylesheet.
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EXAMPLE
Let's say you have two stylesheets in your project—one called "Main-Styles" and the
other "Styles-for-Home-Page." You decide to create a link between the two stylesheets,
so you open Main-Styles.css, select the Options drop-down in the Stylesheet Editor,
and choose Stylesheet Links.

In the Stylesheet Links dialog, you move Styles-for-Home-Page.css from the left to the
right side.
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Back in the Main-Styles.css file, you notice that the color property is inheriting a setting. This is indicated by the gray text. If you hover over this property, you can see that
the color is coming from the Styles-for-Home-Page.css stylesheet.

If you open the Styles-for-Home-Page.css stylesheet and select that same style, you
will notice that the text for the color property is darker, meaning it is the source of that
setting.
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Local Toolbar
Following are the buttons and sections of the local toolbar:
Button/Section

Description
Toggles between an Advanced view and a Simplified view of the Stylesheet
Editor.

Opens the New Selector dialog opens, which lets you create a new selectors of
varying levels of complexity.
A selector is a way to associate HTML content with style settings based on
various information—most often its type, class, or ID. Sometimes the word
"selector" is used interchangeably with the term "style," but a selector can be
much more than just a simple style.
Lets you rename a selector (e.g., class, ID).
Opens a menu, which lets you add a new CSS variable or insert an existing one
into a property.
Opens a menu, which lets you add a new medium or media query. You can also
delete the custom medium or media query that is active in the Stylesheet
Editor.
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Button/Section

Description
Opens a submenu that lets you select from the following options:
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Import Styles Opens the Import Styles dialog, which lets you import individual styles from another stylesheet to the current one. You can import
from one of Flare's factory stylesheets or any other CSS file that you
have access to.

n

Manage Font Sets Opens the Font Set Manager, which lets you add, edit,
and delete a font set.

n

Stylesheet Links Opens the Stylesheet Links dialog, which lets you link
another stylesheet to the current stylesheet. The style classes within the
linked stylesheet are therefore copied into the current stylesheet.

n

Disable Styles Opens the Disable Styles dialog, which lets you prevent
certain styles from being shown in the Stylesheet Editor and in the Flare
interface. This is a good feature if you use only some of the styles
provided in a stylesheet. Rather than being overwhelmed with the sight
of all styles in the stylesheet, you can ensure that you see only the styles
that you tend to use in your project. Those styles will not be removed
from the stylesheet; they will simply be hidden until you enable them.
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Advanced View
Following are the buttons and sections of the Advanced view:
Button/Section

Description

[Styles]

You can use this field to filter which types of styles to show in the area below.

Hide Inherited

Hides the inherited styles from the list below in the editor. These are styles
that do not yet have explicit settings on them, so they are inheriting default values from a stylesheet located elsewhere (e.g., a factory stylesheet stored in
the place where you installed Flare). As soon as you make a change to one of
these styles, it ceases to be an inherited style (or at least the property you set
is no longer inheriting from the default value). In the Advanced view of the
Stylesheet Editor, inherited styles are gray; non-inherited styles are black. In
addition, there are a couple of factory media queries (tablet and mobile), which
are inherited. If you have not yet edited these media queries, they will not show
up in the Medium drop-down field in the local toolbar if you have this option set
to hide inherited.
Toggles between showing the properties in grouped view or alphabetical view.

If you are using the grouped view, this expands all of the property groups.
If you are using the grouped view, this collapse all of the property groups.
Medium: [Name
of Medium]
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You can use this field to select a medium or media query, which opens it in the
editor so you can edit it. This includes factory mediums and media queries, as
well as those that you may have created. If you have "Hide Inherited" enabled,
the factory mediums and media queries will not show up in the drop-down if
you have not yet made any edits to them. In the Advanced view of the editor,
you can have multiple mediums or media queries open at the same time.The
default medium is always placed on the left of the others.
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Button/Section
Show: [Properties]

Description
You can use this field to filter the style properties that are displayed.
n

Set (Locally) Properties Displays properties that have been set explicitly
in the stylesheet. An "Add Property" field is also shown at the top of the
properties. You can use this field to quickly add another property to the
list so you can edit it.

n

Set Properties Displays properties that have been set explicitly in the
stylesheet. It will also show properties that have been set in an imported
stylesheet or inherited properties that have been set in a factory
stylesheet. An "Add Property" field is also shown at the top of the properties. You can use this field to quickly add another property to the list so
you can edit it.

n

Assorted Relevant Properties Displays the properties that are used most
often for the selected style type.

n

All Properties Displays all available properties.

[Styles]

Lists the styles. After you select a style on the left, you can edit its properties
on the right.

[Properties]

Lists the properties relevant to the style that is selected to the left. If the properties are displayed in group view, expand the group to see the actual properties. The property name is displayed on the left. Click
on the right and use
the options to specify the value settings for the property. Depending on the
property, you might set the value by typing an entry, selecting an option from a
drop-down list, or specifying settings in a small popup.
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Button/Section

Description

Comments

You can select the style and then type a comment in the field at the bottom of
the Styles section.

[Preview]

As you make changes to a property's values, you can see how the changes
look in the Preview section at the bottom of the editor.
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Simplified View
Following are the buttons and sections of the Simplified view:
Button/Section

Description

[Styles]

You can use this field to filter which types of styles to show in the
area below.

Hide Inherited

Hides the inherited styles from the list below in the editor. These are
styles that do not yet have explicit settings on them, so they are inheriting default values from a stylesheet located elsewhere (e.g., a factory stylesheet stored in the place where you installed Flare). As soon
as you make a change to one of these styles, it ceases to be an inherited style (or at least the property you set is no longer inheriting from
the default value). In the Advanced view of the Stylesheet Editor,
inherited styles are gray; non-inherited styles are black. In addition,
there are a couple of factory media queries (tablet and mobile),
which are inherited. If you have not yet edited these media queries,
they will not show up in the Medium drop-down field in the local toolbar if you have this option set to hide inherited.

Hide Properties

Hides the properties in the main portion of the Stylesheet Editor. By
hiding the properties you can make the editor load faster than it
would otherwise.

Medium: [Name of
Medium]

You can use this field to select a medium or media query, which
opens it in the editor so you can edit it. This includes factory mediums and media queries, as well as those that you may have created.
If you have "Hide Inherited" enabled, the factory mediums and media
queries will not show up in the drop-down if you have not yet made
any edits to them. In the Advanced view of the editor, you can have
multiple mediums or media queries open at the same time.The
default medium is always placed on the left of the others.
Opens the Properties dialog for the selected style. From this dialog,
you can provide various settings for the style(s), such as changing
the font or the background color.
Applies bold typeface to the font for the selected style.
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Button/Section

Description
Applies italic typeface to the font for the selected style.
Underlines the font for the selected style.
Lets you select a font type (e.g., Arial, Times New Roman), applying it
to the selected style.
Lets you select a font size, applying it to the selected style.
Lets you choose and apply a color to the font for the selected style.
Lets you choose and apply a color to the background of the selected
style.

[Styles Grid]

Columns and rows in the grid display the various styles and classes in
the stylesheet, as well as some of the more common property settings. These grid cells are populated based on the settings you
provide in the Properties dialog (which is opened by clicking
selecting certain buttons (e.g., bold, font size) in the editor.
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n

Name Displays the full name of the style class (the XML tag followed by a period and the name of the class, if any). For
example, if you create a class of the p style called "tip," this
column will display "p.tip."

n

Tag Displays the XML tag upon which the class is based.

n

Class Displays the class name if you have created one (based
on the XML tag).

n

ID Displays the identifier (ID) name if you have created one
(based on the XML tag).

n

Pseudo Class Displays the pseudo class, if one exists (e.g., active, hover, visited).

n

Preview Displays a preview of the style class as you make
changes to the property settings.

n

Comment You can click twice (or click once and press F2) in
this cell and type comment text related to the style.
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Ribbon Options for Editing Styles
Some options in the Home ribbon were originally designed for local formatting only, which is generally discouraged.

However, if you have a stylesheet open, these options can be used to apply formatting to styles in
the Stylesheet Editor. This can speed up the process of editing certain style properties.
EXAMPLE
Let’s say you want to make the h1 style green in your stylesheet. After selecting the
style in the Stylesheet Editor, you could find and set the color property to green.
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However, you could use the color option in the Home ribbon to do the same thing, only
faster.
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CHAPTER 7

Builds Window Pane
This window pane shows targets as they are generated in the interface.
This chapter discusses the following:
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How to Open this Window Pane
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Characteristics
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Toolbar and Context Menu Options
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Organizing Columns
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How to Open this Window Pane
The Builds window pane opens automatically when you generate a target. However, you can also
open it manually by selecting View > Builds or Project > Builds.
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Characteristics
Following are some important characteristics of the Builds window pane:
n

Rows in the Grid Each row in the grid represents a target for which you have initiated a build.
By default the top row is the most recent build.

n

Status/State The Status and State columns in the grid may display any of the following,
depending on the progress of the target build: Running (Building), Finished (Build Complete/Build Failed), Queued, or Terminated (Cancelled).

CHAPTER 7

105

n

Warnings and Errors The last three columns display the number of warnings and errors for the
target. You can open the build log to see details for the warnings or errors. In addition, if you
have set Flare to ignore certain warnings—in the Options dialog (File > Options) or Target
Editor—that number is also given.
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n

Background Colors The Progress cells display colored backgrounds, depending on what happens with the build. When a build is in progress, the background is light green. If the build finishes with no errors (although there may be warnings), the background turns dark green. If an
error prevents the build from finishing, the background is red. If you manually stop the build,
the background is yellow.

Following are descriptions of the three progress columns:
l

l

l

n

Build Progress This column indicates the progress of the entire build for a target.
Compile Progress This column indicates the progress of individual parts of a target's
build.
Publish Progress This column indicates the progress of a target that is being published to
a destination you have set up.

Compile Status As a target is generated, the contents of the Compile Status column change
rapidly (e.g., showing the files being processed).
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n

Warning for Changed Files Because this feature allows you to continue working while targets
are generated, it's possible that you might change a file that is included in a target while it is
still compiling. If that happens, the target continues to build without those changes, but you
will see a warning in the build log to let you know.

If this happens, will your changes make it into the output? That depends on the file(s) that you
changed. Flare processes your source files in the order that it finds them. So if the generation
process already passed the point where it would have grabbed a particular source file, your
changes from that file will not make it into the output. However, if Flare's build process has not
yet reach the file in question, then the changes might make it into the output. You can refer to
the warnings you receive in the build log and then look at the files in the output to see if your
changes made it.
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n

Build Logs Anytime you build a target, a build log is automatically created. By default it is
stored at the root level of the output folder for that target (e.g., <project>\Output\<user
name>\<target name>). However, in the Options dialog (File > Options) you can choose where
your log file will be stored when you build a target. As an alternative to the default location,
you can choose to place it in the Reports folder of the Project Organizer, or you can select a
custom location.
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A build log file has an .mclog file extension. The next time you generate the target, the old log
file is replaced with a new one.

In the local toolbar of the Builds window pane, you can click Open Build Log to see it in Flare.
You can then see more details of any warnings or errors you may have gotten when building
the target.

n

Batch Targets In addition to single targets, if you build a batch target, the process for each
one is shown in the Builds window pane.

CHAPTER 7

110

Toolbar and Context Menu Options
Following are actions you can take in the Builds window pane by clicking a button in the local toolbar. In most cases you can also right-click on a row and select one of these options from the context menu.
n

Clear Finished This clears all rows from the Builds window pane.

n

View Output This opens the output for the selected row if the target finished compiling
without errors. You may need to click on the row (to first give the grid focus) in order to see
this option in an enabled state. You can also double-click a row to open the output for a successful build. Depending on the type of output, you can select the device or browser you want
to use to view the output from a drop-down menu.

n

Open Build Log This opens the log file of the selected row so you can see more information
about any issues with the build. You can also double-click a row to open the log file for a target
that failed to build.

n

Stop Build This cancels generation of the target. You will see yellow cells as a result.

n

Rebuild Target This rebuilds the target for the selected row.

n

Build Targets This lets you build multiple targets. Following are the primary benefits of this feature:
l

l

l

You do not need to have a Flare project open at all in order to use this feature.
You can select targets for any Flare project, even if that project is different from one you
happen to have open at the moment.
This feature functions sort of like a batch target, in that you can choose to build and/or
publish multiple targets. The difference is that, with this feature, you do not need to first
create a batch target file in Flare.
NOTE: Batch targets have their own advantages over this feature. For example,
they allow you to retain your build and publish settings for each target, so that
you can easily reuse them in the future. Also, you can schedule batch targets to
run any time in the future, even if you're not at your computer.

n

Open Output Folder This opens the output folder in Windows for the selected row.

n

Clean Target This lets you remove the content from the output folder for the selected target.
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Organizing Columns
You can reorder or hide columns in the Builds window pane. There are a few ways to do this.
n

First, you can click on a column header and drag it to the right or left, dropping it in a new location.
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n

Second, you can right-click any column header, which displays a menu. Click next to the
column titles (adding or removing check marks) to show or hide those columns in the Builds
window pane.
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n

Third, from the right-click menu, you can select Columns. This opens the Manage Columns
dialog.
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Again, you can show or hide columns by adding or removing check marks next to the column
titles. You can also click and drag the rows up or down to change the order of the columns in
the Builds window pane. Finally, you can click Reset to Factory Settings if you want to undo all
of your changes and return to how everything was initially set.
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CHAPTER 8

Customizing the Workspace
One of the benefits of Flare's user interface is that it is flexible and easy to customize to meet your
needs. Following are some of the ways you can customize the workspace.
This chapter discusses the following:
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Moving, Docking, and Floating Elements
Simply because a window pane or tab is attached to a particular area of the program window by
default, does not mean it has to stay there.
n

Floating and Moving User Interface Elements You can float an element that displays with a
tab by clicking the tab and dragging it down until it floats.
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Another way to float an element is to click on it and select Window > Float.
You can move window panes displayed in accordion view by clicking the "Drag Pane" section
. To drag all of the window panes grouped together, click this button in the upper-left
corner of the window pane. To drag a single window pane, click this button in the accordion
bar for that window pane. Hold down your mouse and drag the window panes where you want
them. If you drop a window pane at a random location in the program window, it becomes a
"floating" window.
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n

Docking User Interface Elements Docking an element that is floating means to attach it to a
particular part of the program window. To do this, click in the title bar, drag it to the edge
where you want to dock it, and drop it onto one of the small squares that appear in the interface. The portion of the square that has color indicates where the window pane will be
docked.
Dock in center of workspace

Dock on left side of workspace

Dock on right side of workspace

Dock on top side of workspace

Dock on bottom side of workspace
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Autohiding Window Panes
In the top-right corner of every window pane, you will see a small button that looks like a pin . If you
click this button, the window pane is hidden (or "pinned" to the edge of the program window).
However, you can still see the title of the window pane along the edge of the program window. When
you hover over the title, the window pane temporarily displays again until you move the mouse off
the window pane. Click the button again to "un-pin" the window pane.

Resizing User Interface Elements
You can easily resize the program window, dialog windows, and floating window panes in Flare by
clicking the edge of the element and dragging the mouse to the desired size. You can also resize
drop-down menus in the same way.
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Window Layouts
When you move window panes, explorers, or editors around in the Flare interface, the configuration
(or "layout") of the workspace is changed. You can do several things with layouts, including the following.

HOW TO SAVE A WINDOW LAYOUT
You can save different layouts of the interface, in case you want to use them for different purposes.
1. Configure the workspace how you want it.
2. Select the Window ribbon. In the Window Layout section select Save Layout > Save Window
Layout As.
3. In the Save Window Layout dialog, enter a name for the layout.
4. Click OK.

HOW TO AUTO-SAVE A WINDOW LAYOUT
You can automatically save the layout of the workspace when you exit Flare. The next time you
launch Flare, that same layout will be displayed.
n

Select the Window ribbon. In the Window Layout section select Auto-save Layout.

HOW TO SELECT A SAVED WINDOW LAYOUT
You can quickly change the configuration of your workspace by selecting a window layout that you
have saved previously.
n

Select the Window ribbon. In the Window Layout section select Layout > [Name of Layout].

HOW TO RESET THE WINDOW LAYOUT
You can return the workspace configuration to the original layout that you saw when you first
installed and launched Flare.
n

Select the Window ribbon. In the Window Layout section select Reset Layout.
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HOW TO RELOAD THE WINDOW LAYOUT
You can return the workspace to the saved configuration of the layout. In other words, if you are
working in a particular layout and have opened different interface elements or moved interface elements around, you can select this option to go back to the saved configuration.
n

Select the Window ribbon. In the Window Layout section select Reload Layout.

HOW TO DELETE A WINDOW LAYOUT
You can open the Manage Window Layouts dialog, which lets you select or delete an existing layout.
1. Select the Window ribbon. In the Window Layout section select Layout > Layouts.
The Manage Window Layouts dialog opens.
2. Select the layout that you want to delete.
3. Click Delete.
4. Confirm the deletion by clicking OK.
5. Click Close.

NOTE: Resetting a layout returns the interface to the way it was when you opened Flare for
the first time. Reloading a layout means returning the interface to your last saved layout.
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Switching Between Ribbons and the Tool
Strip
By default ribbons are used when you install and launch Flare for the first time. However, you can
use the Options dialog to switch back to the classic tool strip, where toolbars and menus are shown.

HOW TO SWITCH FROM RIBBONS TO TOOL STRIP
1. Select File > Options.
The Options dialog opens.
2. Select the Interface tab.
3. In the Menu Style section, select Tool Strip.
4. Click OK.

HOW TO SWITCH FROM TOOL STRIP TO RIBBONS
1. Select Tools > Options.
The Options dialog opens.
2. Select the Interface tab.
3. In the Menu Style section, select Ribbon.
4. Click OK.
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Minimizing Ribbons
You can minimize the ribbons so that you only see the top portion of the ribbons until you select an
option. To do this, right-click anywhere in a ribbon and select Minimize the Ribbon from the context
menu.
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Selecting an Interface Color Theme
You can use the Interface tab on the Options dialog (File > Options) to choose a color scheme for
the interface: black, classic, or silver.
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HOW TO SELECT AN INTERFACE COLOR THEME
1. Select File > Options. The Options dialog opens.
2. Select the Interface tab.
3. Click in the Active Theme and select a color scheme.
4. Click OK.
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Customizing Column Information
In certain window panes, information is presented in a grid. You can configure these grids to change
the way the information is displayed. For example, you can hide or show certain columns, set a background color for a column, or increase the width for a column.
You can use a context menu to simply hide or show certain columns in a window pane, or you can
open the Columns dialog to customize columns even more.

HOW TO HIDE OR SHOW COLUMNS FROM THE CONTEXT MENU
1. In the window pane, right-click on any of the column headings.
2. From the context menu, click next to any column name to remove or add the check mark next
to it. If a check mark appears next to a column name, it will be shown in the window pane. If a
check mark does not appear next to it, the column will not be shown.
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HOW TO CUSTOMIZE FROM THE COLUMNS DIALOG
1. Open the Columns dialog.
2. Use the options in the dialog to do any of the following.

HIDE A COLUMN
n

In the Show column, click the check box to remove the check mark next to the column
that you want to hide in the interface.

RESIZE THE WIDTH OF A COLUMN
n

Double-click in the appropriate Width cell and type the new width in pixels.

SET THE FONT COLOR FOR THE TEXT IN A COLUMN
a. In the appropriate Color cell, click the down arrow and select Pick Color. The Color Picker
dialog opens.
b. Select the color.

SET THE BACKGROUND COLOR FOR A COLUMN
a. In the appropriate Background cell, click the down arrow and select Pick Color. The Color
Picker dialog opens.
b. Select the color.

CHANGE THE ORDER OF THE COLUMNS
a. Select any of the items in the dialog. The row for that item is highlighted.
b. Click the Move Up or Move Down button to adjust the position of the row.
When you are finished, the item at the top of the dialog will display on the far left in the
final interface. The item at the bottom will display at the far right.
3. Click OK.

NOTE: You can also customize column information in the Builds window pane, but the features are slightly different than those described here.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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